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Firefox 3—Hot New Browser
by Ira Wilsker

APCUG Director; Columnist, The Examiner, Beaumont, TX;
Radio and TV Show Host

A
fter a lengthy wait, Mozilla has released the

latest and greatest re-

lease of the very popu-

lar web browser, Firefox 3.

This new release, available for

f r e e  d ow n l o a d  f r om

www.getfirefox.com, has many

new features, making it a very

strong competitor to Micro-

soft’s ubiquitous browser,

Internet Explorer.

Firefox evolved from an earlier browser, Mozilla,

which in turn grew out of the Netscape browser as

AOL announced the cessation of Netscape develop-

ment. Since its first release several years ago,

Firefox in its current and previous versions has

developed a wide following, with hundreds of mil-

lions of copies downloaded. The newly released

version 3 has tentatively set a Guinness world record

with over 8 million copies downloaded in its first 24

hours of public release, despite overloaded servers

that discouraged countless people from downloading

it the first day of issue. According to published

reports, the number of copies of Firefox 3 down-

loaded surpassed 14 million downloads in the first 72

hours. Obviously, many people are using it.

Rhetorically, so why are so many using Firefox 3

rather than Internet Explorer (IE), which is installed
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by default on all contemporary Windows computers?

There are several other fine browsers in circulation,

such as the newly released update to Opera, and

Apple’s Safari (for both Windows and Mac), but for

Windows computers, Firefox is firmly in second

place, right behind Internet Explorer. If Internet

Explorer was not preinstalled on Windows comput-

ers and integrated into the operating system, there

is a good chance that Firefox 3 could surpass IE in a

fair competitive market. Firefox 3 is faster rendering

web pages than IE, has superior tabbed browsing, is

written in tighter code taking fewer system re-

sources, and has many advantages over IE. There is

no reason why PC users should not download Firefox

3 for Windows (7.8mb download), and install it, as it

runs happily on computers that already have IE

installed. 

On a fresh installation of Firefox on a Windows

computer, Firefox will nondestructively import the

favorites (bookmarks), cookies, and other infor-

mation from IE, without making any changes or

impeding IE in any way. If Firefox 3 is installed on

a computer that has an older version of Firefox

installed, it will automatically install it as an up-

grade, including all bookmarks, passwords, cookies,

and other information. Once installed, many users,

such as me, prefer to use Firefox instead of IE. In my

case I would say that I use Firefox for 98% of my

browsing tasks; it would be 100%, but I have IE

setup to access another internet account that I have,

but rarely use.

According to the Firefox 3 website at www

.mozilla.com/en-US/firefox, over 15,000 improve-

ments were made to version 3 over version 2. The

newly released version 3 is claimed to be faster,

safer, and smarter than the previous version, and

also IE! One of the new features, which I have

personally verified, is the fact that web pages do

indeed load faster than on IE and previous versions

of Firefox. Firefox 3 also consumes less system

memory and system resources, leading to improved

computer performance when Firefox is loaded and

running, compared to the previous version, or even

IE. Firefox 3 is also more secure than previous

browsers, and incorporates the latest technologies to

help prevent phishing (identity theft), and other

website forgeries. A neat new feature in Firefox 3 is

“Instant Website ID,” where clicking on the tiny

website icon (“site favicon”) at the left of the URL in

the menu bar will display site information and

identification, which will likely indicate if the site is

as intended, or a web forgery. Firefox 3 has also been

engineered to work smoothly and compliment Vista’s

parental controls, as well as most antivirus and

other security programs.

Another interesting feature unique to Firefox 3 is

the “Smart Location Bar” that shows detailed infor-

mation on websites recently visited, and is accessed

by clicking on the right side of the menu bar. This

Smart Location Bar is intelligent, in that it adapts to

persona preferences to locate better website matches.

Typing a “tag” or keyword in the menu bar opens a

detailed list of previously visited websites containing

that keyword, making it very fast and easy to locate

websites that have previously been visited. Another

very useful feature is the integrated spell checker,

which underlines any misspelled words typed in a

browser window; right clicking on the word opens a

list of suggested spellings, which a mouse click will

instantly replace the incorrect word with the cor-

rectly spelled word.

Malware of various types, including worms,

Trojans, viruses, and spyware is a growing menace

to internet users. Firefox 3 integrates a sophisticated

anti-malware feature that provides some protection

if the user either intentionally or erroneously ac-

cesses a website that contains attack code. If such a

dangerous website is accessed, a full screen (browser

window) display will appear as a warning. Firefox,

working with other organizations (including Google)

maintains a continuously updated list of so called

“attack sites,” so there is nothing for the user to

update or maintain. In the event the user does

happen to fall into a suspect site, such as a very

freshly created phishing (identity theft) website, the

forgery can be quickly reported by simply clicking on

HELP – REPORT WEB FORGERY; this will connect

to a Google service that collects such information on

a real-time basis, verifies the forgery, and auto-

matically adds it to the malware list, as well as

forwards the information to groups like Phish Tank

(www.phishtank.com) for further action.

Many of us use multiple passwords and user

names on countless websites. Firefox 3 has an

excellent integrated and secure password manager.

When a password is first entered, Firefox 3 asks if

you want it to remember that password and logon

information, without any annoying pop-ups. Speak-

ing of pop-ups, Firefox 3 incorporates a sophisticated

and easily configurable pop-up blocker which can

stop pop-ups and pop-unders, speeding and making

more enjoyable the surfing experience. In some

cases, pop-ups are not irritating advertisements, but

instead contain important information; these can be
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easily allowed when desired.

Many of us choose to tweak the appearance and

features of our browsers, and Firefox 3 happily

obliges. Firefox has many themes and “personas”

that can be selectively implemented to change the

appearance of the browser to meet our individual

tastes. For those of us who want additional features,

Firefox offers over 5,000 free “add-ons” (addons

.mozilla.org/firefox), which are easy to install devices

to customize the browser to work as desired. I have

installed about a dozen add-ons, including some

security add-ons (PhishTank, McAfee SiteAdvisor,

and others), as well as an enhanced download man-

ager (the one integrated in Firefox 3 is very adequate

for most users). I also have selected to use differently

colored tabs on the top of the browser window, an

add-on that can make a tab an IE window (for the

rare cases when a website is intended for IE only), a

PDF manager, and several other add-ons.

Firefox 3 is an outstanding and free product. It is

a very worthwhile competitor to Internet Explorer,

and users should try it to see if they like it. I like it,

and use it almost exclusively on my desktop and

notebook computers. That is the best recommen-

dation I can give it.
This article has been provided to APCUG by the author

solely for publication by APCUG member groups. All other uses
require the permission of the author (Iwilsker(at)apcug.net).

Your Next Computer Will Be Green
by Marjie Tucker

Editor, Mountain Computer User Group, GA

W
ith Europe leading the way, the computer

industry is decidedly becoming “green.” The

Waste Electrical and Electronic Equipment

(WEEE) and the Restriction of Hazardous Sub-

stances (ROHS) directives went into effect earlier

this year. These two directives state that certain

electrical and electronic equipment must cut down

on hazardous materials such as lead, mercury, and

cadmium. They also give customers the right to

return their equipment free of charge. Companies

have several years to fully implement these direc-

tives, but the leaders have already started to make

changes. 

Dell, for example, is advertising Energy Smart

workstations and notebooks that can reduce power

consumption by as much as 78%. The Energy Smart

configuration uses a default power setting that is

designed to reduce consumption and energy costs

right out of the box. In addition, the power supply,

fan, and motherboard use significantly less energy to

maintain cool internal temperatures.

HP is using 80 Plus power supplies to lower

energy bills and AMD technology that reduces heat

output and PC power consumption. In addition, they

have already introduced an HP recycling program

where you can trade-in or donate the products.

Government Initiatives Many U.S. government

agencies have implemented standards and regu-

lations to encourage green computing. The Environ-

mental Protection Agency launched an Energy Star

program in 1992 and strengthened its requirements

in 2006. In 2003 the California State Senate enacted

the Electronic Waste Recycling Act and in 2007

President Bush issued Executive Order 13423

requiring all federal agencies to use the Electronic

Products Environmental Assessment Tool when

purchasing computer systems. In addition, a global

consortium called The Green Grid was founded in

2007 by AMD, APC, Dell, HP, IBM, Intel, Microsoft,

Rackable Systems, SprayCool, Sun and VMware.

Another initiative formed by a group of Global-

minded IT executives, the Green Computing Impact

Organization (GCIO), was created to be an active

participant in transforming the IT community from

an environmental liability to an Earth conscious

example of responsibility. GCIO is a nonprofit

organization that is based on environmental audit

programs for consumers and small business homes

with respect to general energy-efficiency programs

(including lighting, heating, in-sulation, etc.). GCIO’s

mission is to educate and assist enterprise technol-

ogy users in the design of environmentally aware

and responsible information system operations. They

help consumers become more en-vironmentally

responsible by reducing energy consumption and

electronic waste in an effort to protect the Earth.

GCIO is sponsoring educational programs across

the country and participating in a Green Computing

Summit that will be held in Washington, DC on May

20th. The summit will address how public sector IT

managers, procurement officials, and program mana-

gers public sector professionals can transform their

IT and data center operations into more environmen-

tally conscious yet efficient solutions. This confer-

ence will attract senior government IT professionals

and their industry partners tasked with helping

agencies become greener in the coming years. Atten-

dees will represent federal, state and local govern-

ments, public policy organizations and suppliers to

government. You can read more about this event at

www.e-gov.com/EventOverview.aspx?Event=SGC

S08.
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Features of Green Computing
Power management is the most popular method.

The operating system of the computer can be set to

directly control the power saving aspects of the

hardware. It can automatically turn off the monitor

or hard drive after a period of inactivity. Or, the

entire system may hibernate, turning off most of the

components such as even allow the user to manually

adjust the voltages supplied to the CPU to reduce the

electricity consumption and the amount of heat that

is produced. As of July of 2007, all new Energy Star

certified desktops must have a power supply that is

at least 80% efficient.

Other features include using motherboard video

output instead of a video card, hard disks that

consume less power, flash based solid state drives

that require fewer write cycles, and lower energy

monitors. And, manufacturers of networking equip-

ment are developing switches and routers that

reduce energy costs.

Recycling Materials
Obsolete computers can be reused for charities,

non-profit organizations, and developing countries.

Parts from really old systems can be recycled

through some recycling centers. Some recycling

charges can be passed back to the manufacturers.

Recycling this equipment keeps the lead, mer-

cury, and chromium out of our landfills. In addition,

computer supplies such as cartridges, paper, and

batteries can be easily recycled.

How Can We Work Greener?
Visit the website for Climate Savers Smart

Computing at sww.climatesavers computing.org to

view a three step program to go green. Here are the

basic steps that they suggest:

Step One
Turn on Power Management. Since the average

desktop PC wastes nearly 50% of the energy it

consumes as heat, it makes sense to use the power

management features that are built into Windows

XP and Vista. The benefits? You will reduce your

electricity bills and your energy footprint will be

lowered as you reduce your greenhouse gas emis-

sions. The Climate Savers organization predicts that

the power management features on your computer

can save nearly have a ton of CO2 and more than

$60 a year in energy costs.

Step Two
Buy an energy efficient computer. Energy Star,

the program designed by the U.S. Environmental

Protection Agency, specifies the standards that

equipment and appliances must meet to wear the

Energy Star badge. You can visit their website at

www.energystar.org for specifics. Basically an

Energy Star compliant PC uses 15 to 25 percent less

energy. This program is expected to save U.S. con-

sumers and businesses more than $1.8 billion in

energy costs over the next five years and prevent

greenhouse gas emission equal to 2.7 million vehi-

cles.

Step Three
Unplug from phantom power. As long as your

computer is plugged in it still uses electricity, even

while it is turned off or in standby mode. A computer

that is turned off, but still plugged in, can use up to

10 watts. The Climate Savers estimate that you can

reduce your electricity bills by as much as 10% by

unplugging your appliances

and electronics when they're not being used. 
This article has been provided to APCUG by the

author solely for publication by APCUG member groups.
All other uses require the permission of the author
(mcug(at)dnet.net).

Uniblue Registry Booster 2
by Terry Currier

Vice President and Webmaster, WINdows usERS (WINNERS),
CA

I
’ve tested a number of programs on my secondary

test computer over the years. I’ve also installed

and uninstalled a number of programs. At start

up the computer loads up my anti-virus, anti-spy-

ware, firewall, UPS monitor, motherboard monitor,

QuickTime, Intel graphics monitor, Maxtor storage

monitor, printer software, TV software, and others.

It takes a while for it to boot up. I turn it on when I

need it, go away to do other things, and come back

after it’s ready. 

Rebooting is even longer with it shutting down

everything and restarting. So I thought Uniblue

RegistryBooster 2 would be something good to try.

Rebooting took 4 minutes 45 seconds. When I first

ran RegistryBooster it found 459 Problems /Errors.

The vast majority being Missing or Invalid Path. 

The Windows Registry in a broad sense is a

database of the hardware and software on your

computer. It contains all your settings for windows

and other software. Whenever you install new

software it creates new settings in the registry.

When you uninstall software it removes all those

registry settings associated with the software, right?

Well it does uninstall the programs, removing it from

the hard drive. Most really do very little removal
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from the registry. So the software is removed, but

the settings are still in the registry and you have a

bunch of orphan links. 

Even before I installed RegistryBooster 2 I did a

backup, for safety sake. It also can create a backup

of the registry before you have it do any repairs. It

can create up to eight backups, keeping the most

recent. Before running it my reboot time was 4

minutes 45 seconds. After running and fixing what

it said were problems I also used it to defrag the

registry. Using RegistryBooster 2 (twice) my reboot

time was down to 3 minutes 39 seconds, saving 66

seconds. Okay that’s great, but for a program like

this you want to make sure there are no problems

later. So I’ve used this for two months now and I can

say I’ve had no problems. I’ve run it about ten times

total. Each time I chose to trust the program with

what it said was a problem. 

Conclusion 
RegistryBooster 2 is very easy to use, and at

$29.95 it is a good value.

http://www.liutilities.com/products/registrybooster/

Requirements: Intel Pentium 4 1GHz or Equivalent

processor, 512 MB RAM, 200 MB free hard disk

space, Graphics mode 1024x768 true color (highest

32-bit), Microsoft Windows 2000/XP/Vista (32-bit).

Internet Explorer 6.
Terry Currier is currently Vice-President & Editor of

WINNERS – WINdows usERS which meets in Fountain
Valley, California. He has been a member of computer
user groups since 1984 (months before he even brought a
computer.) This article has been provided to APCUG by
the author solely for publication by APCUG member
groups. All other uses require the permission of the author
(Tcurrier(at)aol.com).

E-Mailing Photographs
by Richard Kennon

Editor, Amador Computer Users Group, CA

F
irst, we must understand that photograph

(image) size in the camera and in the computer

is measured in pixels. These are the basic dots

of color that make the picture. Do not pay any

attention to anything that says “inches” or “pixels

per inch.” These terms are meaningless when we are

considering a picture either in the camera or in the

computer. They may come into play later if we want

to print the photo on paper. But, that is another

subject for another time. For now, we think only of

pixels. Most cameras record too many pixels to e-

mail. For instance a 6 megapixel camera will make

a picture about 3000 pixels wide by 2000 pixels tall

and the file size may be several megabytes. Our

screens are usually only about 1000 pixels wide

(some are larger and some smaller). So, if we e-mail

the native picture, it will be wider than the screen

for the recipient and the file will be so large, it may
take “forever” to download to the recipient’s com-

puter. It is possible the service provider will not even

accept it.

There are two things we must do to make a photo

e-mailable. The first is to resize or resample the
picture. We want to change the picture width from

3000 pixels to 800 pixels, for instance. This process

is called resizing or resampling. We have to pick the

best 800 pixels out of the 3000 to represent our

photo. Well, no, that is not exactly correct but it

simplifies things to think of it that way. We don’t

have to worry about it because a lot of very smart

programmers have developed ways (algorithms) to

help us. Just remember, you want to resize or re-

sample to get the photo down to a size convenient for

e-mailing. I usually use 800 pixels or 900 pixels

width for pictures I attach to e-mails.

The second thing to do to make a photo e-mail-

able is to save it in JPEG format (.jpg). That is a

format that reduces file size a lot and picture quality

a little so the picture can be downloaded more

quickly and still be nice to look at. Some software

programs give you choices of compression amount

with numbers ranging from 1 to 10. One will result

in a very small file but the picture quality will not be

good at all. A 10 will give the very best quality but

with a very large file size. A reasonable compromise

is to use 5 or 6. I usually use 6.

How do you do this? First, I will describe how to

do it with a free Microsoft program. Then I will try to

look at some other programs.

Microsoft Power Toys for XP has a Resize Pic-

tures toy that is slick and easy but feedback says it

only works on XP. It can be downloaded at http://

www.microsof t . com/windowsxp/downloads

/powertoys/xppowertoys.mspx. Right click on an

image name or thumbnail in Explorer or My Com-

puter and choose Resize Pictures. You are limited to

four specific sizes but they are good choices. They

don’t tell us what compression they are using but the

results look OK. Unless you tell them under Ad-

vanced to replace the image in the file, it will make

a copy. That’s good. They will add the word, “Large,”

“Medium,” or “Small” to the end of the name you

have chosen.

If you are happy with this solution, then read no

further. But, if you want to use a picture editing

program, maybe this will help.
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In Photoshop Elements 5, click on Image> Resize>

Image Size and this window will pop up. Note that

there is some garbage at the bottom about “inches”

but we will ignore that. First we will click the Re-

sample Image box. That puts the Pixel Dimensions

in play and that is what we want. I selected the

Width box and changed the width to 800 pixels.

Since the Constrain Proportions box is selected, that

is all I have to do. 

Note, down at the bottom, that we have several

choices of sampling algorithms. This is frosting on

the cake. I read somewhere that I should use Bicubic

Sharper when downsizing so that is what I do. Most

programs don’t give us all these choices. Then we

should click on File>Save As and give the photo a

new name. I often just use the same name and add

“_800px” so the next time I will know it is ready to e-

mail. Here we can choose the JPEG format and the

compression format and the compression amount.

Photoshop Elements 6 is out now and sells for about

$100. If you are able to spend that much and want

one of the best editing programs, I highly recommend

it.

Let’s look at Picasa2. It is a free program from

Google and looks really good but I do not have much

experience with it. By all means, try it first because

the price is right!

When it comes to e-mailing photographs, it is a

little more automated but not any easier to use than

Elements. First, click on Tools>Options>E-Mail.

Then select the width you want inpixels.There are

six choices. Then click on Apply and OK. 

The next step is to click on File>E-Mail and you

will get three choices of how you want to e-mail your

photos. Fortunately, I use Outlook Express so my

choice is listed.

When I clicked on Outlook Express, an e-mail

page popped up with the photo attached. At this

point we can write something else on the e-mail and

send it. I recommend this so the recipient will know

it is really from you and not something sent out by a

virus. When I receive e-mails that only say “At-

tached,” I Delete them without looking at the attach-

ment. This saved me one time when I received a

virus from my sister-in-law that she did not know

she sent. She spent weeks and dollars getting her

computer back up. Oh, I digress. If you want to send

more than one picture (and, who doesn’t?), you must

select the picture and click on the Hold button near

the bottom of the screen. Do this for each photo you

want to send and they will all be attached to the e-

mail. The program automatically chooses JPEG

format and a compression ratio but does not tell you.

That is OK as the pictures I tried looked good.

Picasa2 has considerable capability for editing

photos in many respects. Try it!

There are many other editing programs that I

haven’t mentioned and have no experience with. In

all cases you want to change the picture’s size in

pixels by resizing or resampling. Pay no attention to

anything that says “inches” as that will have no

meaning for this process. Sometime later we will talk

about printing pictures and then we will use inches.
This article has been provided to APCUG by the

author solely for publication by APCUG member groups.
All other uses require the permission of the author
(Drtrdguy(at)volcano.net).

Email Etiquette
by John Roy

President, The PC Users Group of CT

D
o you really know how to forward an e-mail?

It is estimated that over fifty percent of email

users do not know how to do it properly. Do

you wonder why you get viruses or junk mail? Email

messages get forwarded countless times without

concern for the security of the previous sender’s

addresses. 

Every time you forward an e-mail there is infor-

mation left over from the people who got the message

before you, namely their e-mail addresses and

names. As the messages get forwarded along the list

of addresses builds and builds creating a huge

resource for spammers. All it takes is for someone to

get a virus and the infected computer can send that

virus to every e-mail address that has come across

that computer. Even if the address collection doesn’t

result in a virus it surely will be harvested by spam-

mers or someone looking to make a couple of cents

for a listing of good email addresses. How do you

stop or at least minimize the propagation of email

addresses? There are several easy steps that we

should all practice.

1. Before you send out a forwarded e-mail, DELETE

all of the other addresses that appear in the body

of the message (at the top). That's right, DE-

LETE them. Highlight them and delete them,

backspace them, cut them, whatever it is you

know how to do. It only takes a second You

MUST click the 'Forward' button first and then

you will have full editing capabilities against the

body and headers of the message. If you don't

click on 'Forward' first, you won't be able to edit

the message at all.

2. Whenever you send an e-mail to more than one
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person, do NOT use the To: or Cc: fields for

adding e-mail addresses. Always use the BCC:

(blind carbon copy) field for listing the e-mail

addresses. This is the way the people you send to

will only see their own e-mail address. If you

don't see your BCC: option click on where it says

To: and your address list will appear. Highlight

the address and choose BCC: and that's it, it's

that easy. When you send to BCC: your message

will automatically say 'Undisclosed Recipients' in

the 'TO:' field of the people who receive it.

3. Remove any ‘FW:' in the subject line. You can re-

name the subject if you wish or even fix spelling.

4. ALWAYS hit your Forward button from the

actual e-mail you are reading. Ever get those e-

mails that you have to open 10 pages to read the

one page with the information on it? By forward-

ing from the actual page you wish someone to

view, you stop them from having to open many e-

mails just to see what you sent. 

5. Have you ever gotten an email that is a petition?

It states a position and asks you to add your

name and address and to forward it to 10 or 15

people or your entire address book. The email can

be forwarded on and on and can collect thousands

of names and email addresses. A FACT: The

completed petition is actually worth a couple of

bucks to a professional spammer because of the

wealth of valid names and email addresses

contained therein. If you want to support the

petition, send it as your own personal letter to

the intended recipient. Your position may carry

more weight as a personal letter than a laundry

list of names and email address on a petition.

(Actually, if you think about it, who's supposed to

send the petition in to whatever cause it sup-

ports? And don't believe the ones that say that

the email is being traced, it just isn’t so!) 

6. One of the main ones I hate is the ones that say

that something like, 'Send this email to 10 people

and you'll see something great run across your

screen.' Or, sometimes they'll just tease you by

saying something really cute will happen IT

AIN'T GONNA HAPPEN!!!!! (Trust me; I'm still

seeing some of the same ones that I waited on 10

years ago!) I don't let the bad luck ones scare me

either, they get trashed. (Could that be why I

haven't won the lottery?) 

7. Before you forward an Amber Alert, or a Virus

Alert, or some of the other ones floating around

nowadays, check them out before you forward

them. Most of them are junk mail that's been

circling the net for years! Just about everything

you receive in an email that is in question can be

checked out at Snopes. Just go to http://

www.snopes.com/. It’s really easy to find out if

it's real or not. If it's not, please don't pass it on.

So please, in the future, let's stop or at least

minimize the junk mail and the viruses by taking the

steps outlined above.
This article has been provided to APCUG by the

author solely for publication by APCUG member groups.
All other uses require the permission of the author
(johnroy1(at)comcast.net).

“Help! My PC Won’t Start”
Q. I recently moved my desktop computer. When I

tried to start it, nothing happened. It won’t turn on.

Any help would be appreciated, Mr. M.

A. First, remove then plug the power cord into the

back of the computer. Make sure it’s inserted se-

curely. Likewise, make sure it’s plugged into the AC

or power strip or whatever your source of power is.

Also, be sure that the outlet it is plugged into is

functional. Try plugging in a lamp to confirm that it

is. Do the same thing if you’re using a power strip or

surge protector, just to be certain everything is

functioning independently.

Next, check the back of the computer in the area

where you plugged in the power cord. Look for a

switch with a little horizontal line on one end and a

little circle on the other. The line means “On,” so

make sure that it is turned on. It’s very easy, when

moving a computer, to accidentally toggle that switch

to the “Off” position.

If the power switch is on, and everything is

plugged in securely, the electric outlet is working, as

is any power strip or surge protector, and you still

can’t start your PC, then it’s time to contact a repu-

table computer repair service and have them check

it out. It may require something as simple as replac-

ing the system’s power supply unit. 

Q. Is there a way to configure Word so it will auto-

matically leave two blank spaces after a period at the

end of a sentence?

A. Yes, you can do that, though one space after a

period is the standard these days. Years ago, it was

two spaces, but for most publications today, one

space is preferred. 

Microsoft Word does not provide an ATS (auto-



8

matic two-space) setting, but you can configure

Word's grammar checker to note any spacing anoma-

lies. To do that, click Tools > Options > Spelling &

Grammar tab > Settings button. Use the “Spaces

required between sentences” drop-down list to

establish how many spaces you would like between

your sentences, followed by OK to close the Gram-

mar Settings dialog box, then OK to close the Op-

tions dialog box.

The grammar checker will flag any sentences

that do not conform to your spacing preference by

displaying a green wavy underline. When you right-

click that line, you’ll be able to correct the spacing for

that occurrence.

Q. I know this is probably a stupid question, but

what does “URL” stand for?

A. First and foremost, there are never any stupid or

silly questions here in Mr. Modemville. For most of

us, Geekspeak is not our native tongue, so if you

encounter a word and you’re just not sure what it

means, “Ask Mr. Modem.” 

Having said that, depending who you ask, URL

stands for either “Uniform Resource Locator” or

“Universal Resource Locator.” I was always a uni-

form kind of guy since my days in the Boy Scouts, so

I prefer “Uniform Resource Locator.” A URL is the

unique address of a resource on the Internet. A

“www” URL, commonly called a Web address, ap-

pears in the Address bar near the top of a Web

browser. For example, the full URL or Web address

for my Web site is http://www.MrModem .com,

though URLs are typically shortened to www

.MrModem.com or even MrModem.com.

Mr. Modem’s DME (Don’t Miss ‘Em)

Sites of the Month
Craftzine

A project-based, online magazine dedicated to do-

it-yourself crafts. The Projects section gives crafting

a modern makeover, mixing traditional art with

modern elements such as technology, recycling, the

use of creative materials, and toxic waste (just

kidding). Lots of free information is available on the

site, though visitors are encouraged to enter a paid

subscription. 

www.craftzine.com

Historic Tale Construction Kit
Whether you are a history buff or just trying to

look busy at work, this site lets you create your own

story from the Middle Ages, complete with warriors,

beasts, and shamans. When finished, you can submit

it to the site so others can view it, or email it to

annoy as many friends as possible. The process is a

bit like writing your own comic strip in individual frames.

http://tinyurl.com/t3xe

New York Public Library Digital Gallery
You don’t have to live in the Big Apple to experi-

ence one of the most impressive libraries in the

world. The New York Public Library Digital Gallery

Web site provides visitors with free access to half a

million digitized items from its collection.

http://digitalgallery.nypl.org/nypldigital

Mr. Modem’s weekly newsletter delivers helpful

computer tips, great Web sites and his personal

answers to your questions! Trial offer: Subscribe

online using Promo Code FREEMO and receive one

free month with your six-month subscription (28

issues!) To view a sample issue or subscribe, visit

www.MrModem.com. 

Botnets
(Keeping Your Computer Safe on the Internet)

by Brian K. Lewis, Ph.D.

K
eeping your computer safe while connected to

the Internet is becoming more and more

difficult. The “attackers” are becoming more

sophisticated and are sharing more ways to get their

software into your computer. Business Week recently
ran an article on the major security problems ex-

pected in 2008. 

Unfortunately, most of them arrived long before

the New Year started. We have been warned for

years that it was possible to recruit unprotected

computers into networks that could be controlled by

an external source. This recruitment network prob-

lem has gotten much worse over the past few years.

It is estimated that 7% of the computers connected to

the Internet have been infected with a Botnet pro-

gram. So what is a “Botnet”? 

A robot or “bot” software program allows a

computer to be remotely controlled without the

knowledge of the computer's owner. When you have

a number of “bot” controlled computers it is referred

to as a “botnet.” All of the computers in the botnet

carry out commands issued by the network control-

ler. Just one example of what can be done with a

botnet is the sending of spam. The controller can

easily have 100,000 computers in its network. So the

botmaster will contract to send out one million email

messages. The network can then send ten messages

from each of the compromised computers. With the

constant connection to the Internet using cable or

DSL the computer owner will have no idea that

his/her computer has been the source for ten spam
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messages. 

Now you might say that the idea that someone

can control 100,000 computers in a botnet is ridicu-

lous. However, as of October 2007 a major Internet

security service had the IP addresses of over 12

million computers that were infected with bot soft-

ware. There is also a newer threat called the Storm

Worm botnet that has infected millions of computers

just this year. In addition to its computer recruiting

ability, it has built-in defenses that are preventing

security services from analyzing it. In an E-Week
article it was noted that “... Storm worm is sending

DDoS attacks to not only the researchers looking

into it but to anybody on their subnet, within 5

seconds of (their) initiating efforts to fight it or

examine it.” A DDoS attack is a “distributed denial

of service” which can bring down a computer system

or network by overwhelming it with messages. A

very large volume of messages are sent by the botnet

in a very short period of time. It is estimated that

the Storm net controls over one million computers.

This would make it the most powerful super-com-

puter in the world, exceeding the computing power of

all previous computers. 

People frequently wonder why anyone would

want to produce viruses, worms, and other kinds of

Internet attacks. Years ago it was primarily because

“they could do it.” Today, it has become a real source

of financial gain. Let's take a look at one financial

resource created by controllers of botnets. On many

web pages you find ads of various types that are

sponsored by Google. When these ads are clicked, the

advertiser pays Google who, in turn, pays the owner

of a web page, usually 80% of the fee. So the bot-

master sets up a web page and contracts with Google

to display ads. Then, using the botnet sends com-

mands to the computers in its net to click on the ads.

This results in payments to the botmaster. So even

with a small botnet of say 5-10,000 computers, the

botmaster can easily obtain $15,000-$20,000 per

month in fraudulent payments. When you consider

that the known botnets all have more than 100,000

compromised systems, you get a better idea of the

scale of the fraud involved. This type of click fraud

has been estimated to make up 5-20% of the pay-

ments made by search companies. 

Another use of large botnets is extortion. The

botmaster can send an e-mail to a corporation

warning that a DDoS will take place at a specific

time unless a payment is made. As I mentioned

earlier, spam e-mail contracts are also a source of

revenue for botmasters. As these networks prolifer-

ate, the sale of the IF addresses of robotically con-

trolled computers is also favored as an income

source. 

So far it would appear that the only persons

affected by botnets would be corporations. However,

if your computer is infected, everything you do can be

reported to the botmaster. Bots can incorporate “key

logger” software. That will record keystrokes, espe-

cially any related to passwords, user names or other

desirable information. Another function of bot soft-

ware is screen capture. It can record an entire screen

and transmit the data to the botmaster. A compro-

mised computer can also be used as a base for

finding other unprotected computers to be recruited

into the net. Another consideration is that the

largest number of computers is in the hands of

private individuals. So you may be a major part of

the problem if your computer is infected by a bot. 

Once a computer has been compromised, the bot

software is usually designed to hide and protect

itself. For example, it will search for and disable any

other malware located on the computer or its associ-

ated network. It may also hide itself by means of a

rootkit. It may also block updates of any anti-virus or

anti-spyware software. It may even fake the process

so the user believes that an update has taken place.

One of the most common modifications involves

changes to the Windows host file or by changing the

location of the host file and altering the registry. 

There are also some traps on the Internet that

can lead a user to download bot (Trojan) software

without realizing it. Phishing email can lead to web

pages that have automatic download links for bot

software. Web pages can be hijacked and links added

to lead the viewer to web sites that contain “free”

software links that are actually hidden bot pro-

grams. Bot programs are incorporating “social engi-

neering” functions which serve to entice users to

unknowingly download malware. People are the

weakest link in the security chain. E-mail, web

pages, instant messaging, social contact web sites

are all used by bot malware as a means of collecting

information and linking to compromised computers.

Many times the actions of a computer user are

governed by visual clues. An attacker may take

advantage of this by providing false visual clues on

a web page or a pop-up. If the dialog box or popup is

intrusive the user may click inappropriately just to

get rid of the intruder This can lead to the download

of a bot. 

So how do you know if you've been infected? The

easiest way to tell is related to how you have been
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protecting your computer from infection. Do you have

all of the following? 

a) Hardware firewalL 

b) software firewall that checks both incoming and

outgoing messages. 

c) anti -virus software that is updated at least

daily. 

d) anti-spyware software that you either run weekly

or that runs in RAM constantly. 

e) keep your Windows software patches up to date.

If you don't use any of these safety mechanisms,

then your machine is almost 100% guaranteed to be

compromised. Even if you have taken all of these

precautions, you can still be infected However, the

most effective mechanism for dealing with bots is to

prevent their getting into your computer So you have

to keep the software up to date and you have to use

it. 

Ideally, your firewall hardware/software combi-

nation should keep you invisible on the Internet. Bot

programs are constantly searching for unprotected

computers with open ports. You may not be aware

that your computer has over 64,000 ports that can be

used for communication. The most common usages

are the ports in the lower range, tmder 1,024. 

However, some bots use high end ports (>60,000)

for transmission of commands. One place you can

check your computers port and its invisibility on the

Internet is www.GRC.com. The Gibson Research site

provides a free port scan and much good information

on interpreting the findings as well as how to protect

your system. 

Ideally the anti-virus and anti-spyware software

would be able to find and remove any bot software

that made its way onto your computer However, this

software needs to know the “signature” of the mal-

ware in order to identify it. So the producers of the

malware are always a step ahead of the good guys. 

The security services have to find and disassem-

ble the new malware before they can devise the

protection against it. So it is up to the user to keep

the security software as current as possible to reduce

the chances of infection. Like it or not, security on

the Internet is a never ending battle. 
Dr. Lewis is a former university and medical school

professor of physiology. He has been working with per-
sonal computers for over thirty years, developing software
and assembling systems. This article was reprinted from
the Long Beach Computer Club monthly newsletter. 

Mathematical Expectation and

Computer Security
by Michael Gemignani

Houston Area League of PC Users, Inc.

Two Fundamental Laws of Computer Security

T
he Internet contains lot of advice on how to

protect your computer from malware, that

nasty stuff that can toast your hard drive,

steal your credit card numbers and create endless

havoc on your monitor. There are some pieces of

advice I find almost laughable.

For example, some folks tell you to beware of

buying something over the Internet using a credit

card. If you are dealing with a reputable site like

Amazon.com, or using a legitimate service like Pay-

Pal, you are, in my opinion, less likely to have your

credit card number stolen than if you give it to a

waiter in a restaurant who runs off with it to the

back room to ring up your tab. On the Internet, as in

real life, if you know who you can trust, you are

relatively safe.

There are, however, two fundamental laws that

I will give you to help you keep your PC out of the

clutches of the bad guys....

Law #1: Malware cannot do anything unless you do

something first that enables it to do something.

Law #2: Malware that cannot do anything can be

safely ignored.

Let me explain. If malware is to find a home on

your PC, you must have done something, or omitted

to do something, that allowed it in. Thus, the first

line of defense in protecting yourself from malware

is to make sure malware can’t find your computer;

or, if it finds it, entry is barred. That is, the malware

cannot install itself or make any changes whatsoever

to your machine. It’s like preventing a burglar from

entering your home by using burglar bars and a

guard dog.

If, however, malware is able to install itself on

your machine, then the next line of defense is to

insure that it cannot carry out any mischief. While

the best defense is to remove the malware com-

pletely, the next best is to make certain that it will

never be allowed to run. And a last line of defense,

should the malware find a way to run, is to make

sure it cannot do any harm. Here the would-be

burglar has been able to enter your home but is

immediately set upon by the guard dog and immobi-

lized.

The cat and mouse game between PC users and

malware developers is becoming increasingly sophis-
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ticated with new strategies being developed almost

daily by both sides. But the first line of defense

remains you, the computer user. If you visit ques-

tionable sites, download pirated files, and click on

any link that promises something interesting (yes, I

know it is the funniest joke anyone ever heard), you

are going to get malware. I guarantee it. Thus, if you

are not sure that what you are doing is safe, don’t do

it.

There are, however, both hardware and software

designed to protect you from your weaker nature. In

this column I will talk primarily about protecting

yourself in ways related to Law #1. We will consider

protective mechanisms related to Law #2 in my next

column. Your first line of defense, other than your

exercising due caution, is generally a firewall.

Firewalls can provide protection in several

different ways. One defense is at the application

layer (AL). A software firewall using an application

layer defense allows Internet traffic to and from only

those applications you specify. If you authorized the

firewall to allow Firefox to access the Internet, then

the firewall will permit traffic to and from Firefox. If

you did not give such authorization, then the firewall

will block traffic to and from Firefox; that is, you will

not be able to use Firefox on the Internet.

Another form of firewall protection uses network

address translation (NAT). Your computer identifies

itself on the Internet by means of its IP address.

Your IP address allows servers on the Internet to

identify your particular machine; it is analogous to

your home’s street address. However, if someone

knows your computer’s IP address, he can attack it

at will, probing it at leisure until he finds some

weakness that enables him to compromise its secu-

rity. In essence, a firewall using this method masks

your IP address so that your machine becomes

invisible to potential attackers. If your router has a

firewall, the chances are that it uses NAT.

A firewall using an AL defense is like a guard dog

that allows only the people you have trained it to

trust to enter the house. A NAT is akin to making

your house invisible so that burglars can’t find it.

Other types of software are designed to protect

you using the principle stated in Law #1. For exam-

ple, there is software that identifies potentially

dangerous sites. LinkScanner Pro from Exploit

Prevent Labs, which also comes in a free Lite ver-

sion, will examine URLs and warn you if a link is a

known threat. It also purports to scan incoming

network traffic and warn against known attempts,

so-called exploits, to deliver malware to your com-

puter. You can query LinkScanner concerning a

specific URL, or, if you get a list of URLs from a

search service such as Google, it will scan each URL

and warn you if any of the sites listed represent

possible threats. This can, however, slow down your

searches while you are waiting for LinkScanner to do

its thing.

Most browsers also allow you to set your desired

level of protection ranging from “Anything goes” to

paranoia.

Browsers now generally have pop-up protection

– clicking on pop-ups can sometimes download

unwanted software. Many also warn against known

phishing sites, that is, sites that may appear legiti-

mate but, in reality, are just trying to get you to

reveal a credit card number, your social security

number, a bank password, etc.

You may also get a warning that a URL is not

what it seems to be, in other words, the possibility

that someone may be trying to redirect you to a

dangerous site by presenting you with a URL that

looks legitimate.

In addition, your browser should warn you if a

download is being attempted, so that you can decide

whether or not to accept it. Do not allow any down-

load to proceed unless you are sure you know what it

is. You can always save the download before install-

ing it and test it with your antivirus software or

query the Internet to see if the file is a known

danger. In other words, your browser already has a

number of safeguards built into it to keep malware

at bay, provided you activate them or do not disable

them.

If malware does slip through your safety net, all

is not lost, as we will see in my next column. But

learn from your mistakes. It is not those who make

mistakes who deserve to be censured. It is those who

repeat them.
Dr. Michael Gemignani, an attorney and Episcopal

priest, is also a former professor of computer science who
has written extensively on legal issues related to comput-
ers. Although he is now retired, he enjoys writing and
speaking about computer law and security. Send him your

questions or comments to mgmign2@hal-pc.org. From the
June issue of HAL-PC Magazine, newsletter of the
Houston Area League of PC Users, Inc.
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From The DealsGuy
by Bob (The Cheapskate) Click

Greater Orlando Computer Users Group

W
hile working the IBM Rational Software

Development Show, I visited with the guys

maintaining the registration, cyber café and

the classroom setup. They told me they were using

VMware for the classrooms and one actual machine

could support three or four virtual machines. Since

each training class was for a different purpose, some

virtual machines were set up for different applica-

tions. I assume that the best reasons for using

virtual machines is the hardware saving, less heat

and lower power consumption, which all translates

to lower costs.

In another conversation, I had noticed that

security people were not scanning the badges of

attendees entering the exhibit floor, but there was

electronic equipment there. I asked if there were

RFID chips in the badges and they confirmed there

were. When an attendee passes through the en-

trance, the RFID chip in his badge is detected and

the data is recorded for various purposes. The

technician also mentioned that while on the show

floor, the attendee could also be tracked when he was

near an exhibit. As the RFID chip nears the booth

exhibit, a sensor detects it and even would know the

time duration the person was at the exhibit. I as-

sume that service would cost the exhibitor.

He told me the attendee could opt out of the

RFID chip when filling out the registration form, but

only about 1% do that. I wonder how many people

who are always in a hurry to fill out the application

even noticed that option on the form. I would prefer

not to be tracked.

Are You Interested in a Second Life?
At a Central Florida Computer Society meeting

<http://www.cfcs.org> Hewie Poplock and Mike

Ungerman did a fascinating presentation on having

meetings on the Net instead of in person, or even a

combination of both. They used two projectors so the

audience could see both laptop screens and what

each presenter saw on their own screen. The displays

sometimes included another member who joined

them from his home. The presentation had a few

glitches because they had not worked with it a lot,

but Hewie and Mike are experts who will work out

the bugs and refine the process to make it work.

They also demonstrated Dimdim <http://

www.dimdim.com>, a free Web Working conference

site, Paltalk <http://www.paltalk.com> where you

can video conference with up to 10 people, or voice

and type chat to hundreds in public or private rooms,

and Microsoft Live Meeting. They said the Associa-

tion of PC User Groups is presently negotiating with

Microsoft to obtain a license for Live Meeting for

every APCUG user group and that there are several

more applications that facilitate video chatting or

conferencing; including a new Adobe site <http://

www.acrobat.com> where you can try Connect Now,

presently in Beta testing. Here is a comparison Web

site. <http://hewiep.googlepages .com/ fcs20080615>.

Along the way, they also threw in a little about

Second Life, a Web site that seems to have become a

fascination for some folks and perhaps a sort of

addiction for others <http://www.secondlife.com>. At

Second Life you create a new, but virtual, life of your

own, even creating and building just about any

virtual item you wish. Second Life seemed limitless

and you can buy virtual items, or sell virtual items

you have constructed, using Linden dollars. Some

“residents” of Second Life have actually been able to

earn a lot of real dollars by converting Linden Dol-

lars into U.S. currency at L250=$1. It was all com-

pletely new to me and the traffic on that Web site is

tremendous. Hewie has a friend who spends up to 10

hours a day on the site.

Just Paste in a Note
How often do you want to write something down

for future reference while you’re working on a pro-

ject? Probably more than you realize. Flashnote can

be helpful when you work with text and Flashnote is

absolutely free software so it’s easy to take a look at

it. Whether you’re recording a telephone number,

saving a URL to reuse, or just copying pieces of text

for editing, you could use a personal information

manager or some other program for creating and

saving text, but most of those options are slow.

Flashnote is small, quick and convenient so here is

a way to save time. <http://softvoile.com/flashnote

/?s=news4.5>

Keep Track of Everything with This One!
Remembering all the things that have been

planned can be a major nuisance, and when impor-

tant tasks get neglected it can be really serious so

here is a personal information manager. Efficient

PIM Software announces the release of EfficientPIM

version 1.61, the newest upgrade for its flagship tool,

enabling you to maintain and secure personal infor-

mation, make task lists and schedules, write notes,

memos and even diaries to immortalize your mem-

oirs. All this information can be password protected.

With the Password Manager, you need to remember
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only one password to be able to record and find the

others.

The Calendar display, Edit Note and Desktop

Note functions have been improved from the previ-

ous version. You can literally stick some important

notes on the desktop the way you do adhering paper

notes to the fridge. EfficientPIM relieves your busi-

ness life, enabling you to record, not only the infor-

mation about your contacts, but all the events or

appointments connected with them. The patented

embedded search engine allows you to perform

comprehensive searches, enabling you to find every

piece of information you once recorded to the pro-

gram.

EfficientPIM runs under Windows 98, Me, NT4,

2000, XP, 2003 and Vista and costs $39.95 (USD) for

a single-user license. A coupon code “EFFI-OMRW”

gives user group members a 20% discount. Enter the

coupon code in the EfficientPIM purchase page. This

coupon code expires on Oct. 31, 2008. Licensed users

are entitled to free updates and priority technical

support for 24 months. More information is available

at <http://www.efficientpim.com/>.

Direct download link: <http://www.efficientpim

.com/download EfficientPIM-Setup.exe>

Sib Icon Editor Goes Freeware
SibCode announces the release of Sib Icon Editor

4.0. The new version of this renowned icon editor is

now being offered at no charge, and is available

under a freeware license. Sib Icon Editor is a fast

and lightweight image-editing tool designed for

creating and editing icons, toolbars, navigation

buttons, small logotypes and similar graphics.

Fitting the niche between simplistic Windows Paint

and the almighty Adobe Photoshop, Sib Icon Editor

offers small-graphics designers a way to unleash

creativity without the steep learning curve.

Sib Icon Editor supports icons, toolbars, logos and

other graphics of any size, color depth or aspect

ratio. Both 16 and 256-color images are supported

while 32-bit graphics gets alpha-channel support for

creating images with no edge jaggedness. The

alpha-channel comes in handy when adding semi-

transparent shadows that look extremely effective on

Windows XP and Vista. Sib Icon Editor offers a

choice between a number of pens, sprays and paint-

brushes. There is the usual bucket tool for filling the

void, and there are gradients and chess fills to

quickly achieve desired effects.

Only a few clicks will add a translucent or

opaque shadow, modify opacity, colors, and gamma.

Disabled icons are typically grayscale, so there is a

tool for that as well. Tools for smoothing, inverting,

and colorizing images are also available. The result-

ing image can be saved in ICO, ICPR, BMP, JPEG or

PNG formats. Sib Icon Editor can also convert Mac

icons into Windows format.

Sib Icon Editor is available for free at

<http://free-icon-editor.com/>

Beep Beep What??
I had some space left and would normally include

some kind of freebie, but here is a tip I found in

“Nuggets from Nuvo” by Joe Nuvolini, a great

monthly column in the Pikes Peak Computer Appli-

cation Society newsletter, Bits Of Bytes <http://
ppcompas.apcug.org>. What’s your state of mind

when your computer does not come to life, but

instead only gives you certain beeps? File this

information away where you can lay your hands on

it if, some day, that happens instead of booting.

What do those beeps mean? Visit <http://networking

.ringofsaturn .com/PC/beep php> to get a list of the

beeps. I wish my readers could read all the newslet-

ters that I see for the valuable bits of information

they contain. Not that I would know what to do with

that information, but some of you might.

That's it for this month. I’ll have some other new

product announcements on my Web site. Meet me

here again next month if your editor permits. This

column is written to make user group members

aware of special offers or freebies I have found or

arranged, and my comments should not be inter-

preted to encourage, or discourage, the purchase of

any products, no matter how enthused I might

sound. Bob (The Cheapskate) Click <bobclick at

BellSouth dot net>. Visit my Web site at <http://

www.dealsguy.com>.

Norton Internet Security 2008
by Ted Littman

North Orange County Computer Club 

I
t comes in a large yellow box (unless you down-

load the program from

the Internet) that con-

tains one CD, a 34page 4½

x 7 inches User Guide, and

a separate card on install-

ing and activating the soft-

ware that repeats what is

in the Guide. The User

Guide also covers Getting

Started and Responding to

Emergencies. But brevity

is the theme. 

Now don't get me wrong — I like the Symantec



14

product and have always found that it gives my PCs

proper protection. And each subsequent version has

been an improvement over the prior ones. But, if you

have problems, you may get some help from the

electronic Help file, but more than likely you will

need to get more guidance from the Symantec web

site or other Internet resources. Free technical

support is available via email and “live chat” from

within the program. 

The 2008 suite provides extensive protection

including AntiVirus, 2-way Personal Firewall,

Antispyware, Antiphishing, and Identity protection

plus Rootkit detection. Web site authentication and

more. While not included in the program that I

received, you can download a free add-on pack that

gives you parental control and e-mail antispam

protection (for Microsoft's Outlook and Outlook

Express). The software can be installed on three

computers with XP or Vista operating systems, and

comes with a 1-year subscription that will automati-

cally keep the suite's elements updated for maximum

protection. With a list price of $70 (currently reduced

$10 at http://www.symantec.com/norton/products

/overview.jsp?pcid=is&pvid=nis2008) and a street

cost of $50 or less (http://www.amazon.com/Norton-

Internet-Security-2008-Users/dp/B000T9LUBU), the

price is reason-able for a well integrated commercial

product. 

While not everyone is sold on Norton, PC Maga-
zine has again selected Norton Internet Security
Suite 2008 as its Editors' Choice security suite: “The

unobtrusive firewall is tough as nails, and it actively

identifies and blocks exploits and other intrusions.

NIS 2008 did a super job of cleaning up malware in

testing, and its cleanup is significantly more thor-

ough than most. The new Identity Safe manages

your passwords and personal information effectively.

And if you have a problem, help is built right in.”

But, Amazon.com reviewers on average only gave

NIS 2 'l2 stars out of a possible 5, with negative

comments on “Bloatware” (it slows down your PC

and increases boot time), but positive ones on the

improvement of 2008 over past years as well as its

protection capability, graphic interface, and ease of

use. If you need security software and don't opt for

the various freeware and shareware programs, you

can download an NIS trial program and run it for

two weeks before deciding. 

There also is a 60-day money-back guarantee if

you buy NIS and don't like it. If you want to read

more on reviewers' comments, use the aforemen-

tioned amazon.com link Whatever you do, don't

install multiple antivirus or firewall programs as

they are likely to cause major conflicts in your

computer. 

I installed the NIS 2008 software on three com-

puters, an Acer 64-bit laptop with Vista Ultimate, an

old Dell 500 MHz desktop with Windows XP Pro, and

a newer Dell 8400 P IV, 3.2 GHz with 1 ME Ram and

XP Home Edition. In the 8400 machine, I also

installed NIS on a second partition that has Vista

Ultimate. In all cases except the Dell 500, I had a

previous version of NIS that was automatically

removed. The old Dell had several free security

programs that had to be removed manually to avoid

conflicts with Norton. Needless to say, everything

went smoothly during installation and afterwards.

During the process, the files on your CD will be

updated if newer ones are available from Symantec's

web site. And, yes, you do have to “activate” the

software after installation—a minor nuisance since

Symantec only requires your consent and the process

is automatic and fast. 

I have been using the NIS program for a long

time and, to the best of my knowledge, it has fended

off all attacks. For example, I get quite a few emails

forwarded to me from several noccc.org accounts and

occasionally, they include attachments with viruses

and other malware that the Norton AntiVirus

program intercepts and removes and then flashes an

unobtrusive note on the screen alerting me to its

actions. 

In the past, I too have been critical of the suite's

growth and attendant impact on PC boot and operat-

ing speed. The latest version of NIS shows that

Symantec is paying attention to customer (and

reviewer) complaints. In the past also, I have had

problems uninstalling NIS completely when there

were PC problems requiring its removal and rein-

stallation. Now, if the normal Control Panel proce-

dure won't work and you can't remove all of the

program files and Registry entries manually, you can

download a removal tool from the Symantec web site

that does the job nicely. 

One final thought. Although a number of reviews

indicate that some manufacturers o f  i nd iv idual

security programs (like antivirus or antispyware)

may be superior to those in NIS, I doubt that you

will find an integrated suite better than the

Symantec product. And the price is reasonable after

discounts/rebates; in fact, sources like Fry's regularly

have promotions where your final cost is only the

sales tax on the product! 
From the June 2008 issue of  HAL-PC Magazine,
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newsletter of the Houston Area League of PC Users..

Adobe Photoshop CS3 One-on-One
by Mike Yates

North Orange County Computer Club

I
f you are a beginning to intermediate user of the

Photoshop program, Adobe Photoshop CS3 One-

on-One by Deke McClelland is a good book for

you. Published in 2007,

this text addresses the

latest raster graphics pow-

erhouse software from

Adobe which is available

as a standalone program

and one of the main ele-

ments in the Creative

Suite 3 (CS3) clusters of

graphics manipulators. I

loaded CS3 in the form of

the Design Premium pack-

age and the Web Premium

package, so my version was "Extended 10.0.1." To

run only Photoshop, you need at least 512 ME of

RAM or 1 GB for the suite (I upgraded to 2 GB), 2

GB of hard disk, DVD Drive, and at least a 1024x768

monitor. 

The book is laid out as 12 tutorial lessons,

grouping similar topics together. Lesson 9, for

example, discusses Layers, a key element in many

graphic programs' tool bag, starting with both the

benefit and the penalties of using layers and how to

manage, arrange, modify, import, transform, mask,

blend, warp, and align layers. For the faint of heart,

rest assured. You would have already worked your

way through the basics. The in-depth lessons start at

the beginning with what Photoshop is for, how to

open a photo (image), how to organize your images

for efficient use and a section that taught me a lot on

how to use thumbnails and the "metadata" that is in

the image. 

Even though the mood is light and easy to read,

thanks to a good layout and textbook design, the

instructions are detailed, starting with a nice touch:

precise steps on setting up the preferences, defaults,

shortcuts, and tutorial files on the accompanying

DVD to match the textbook photos and screen shots

as closely as possible. Developed by professional

trainers, half of the 500 pages are photos or illustra-

tions or screen shots so that you can see the text

topics in action. "Pearls of Wisdom" add highlights to

the reading. The book is focused on basic Photoshop,

but McClelland is to be applauded for addressing the

Interactions in the Suite versions as well. 

The instructional approach is to read the intro-

duction to the lessons for an overview, then go to the

DVD video for that lesson, then go back to the text.

The DVD provides 10-17 minute demonstrations

using high resolution formats designed to make the

trainer's action easily viewed on PC displays, using

QuickTime. The DVD is a key to the value of this

book, providing student files matching the text to

read-then-do. At the end of the Lesson are review

questions. Those not interested in all program

features might read the lesson intro, watch the DVD

and skip the parts of the lesson not of interest. I

loved the "Extra Credit" sections; some added addi-

tional insight, othert:; told you where you could stop

this lesson and skip to the next if you had not much

interest in that topic. 

Some minor gripes: 1) The book covers both MAC

and }"" command keystrokes which I found slightly

disconcerting and confusing as I moved from text-

book to screen and back in detailed operations.

(Maybe a font difference would help.) 2) This is so

close to traditional textbook layout, why isn't the

review followed by "exercises" tasking the avid

student into more thought or in combining the topics

presented, to ingrain the concepts, based on partially

completed files supplied on the DVD? (This gripe

might be considered a positive; I left the book want-

ing more rather than bored.) 

Like almost any offering of the O'Reilly Media

family, this text DVD combo is worth its price,

$49.99 before the user group discount. Advanced

users may not find it a suitable reference text, but I

suspect they will learn tidbits from it. This neophyte

gives a strong "thumbs up" recommendation. 

For more information, check out the O'Reilly web

site at http://www.oreilly.com/catalog/9780596529

758/. 
From the June 2008 issue of  HAL-PC Magazine,

newsletter of the Houston Area League of PC Users, Inc.

Price Reduction on a Recent Purchase?

 Get a Refund!
by Steve Bass

S
ay you bought something at Best Buy, Costco,

Staples, or Sears. A week later, the price drops

and you're PO'ed because you paid too much.

Listen to this. My buddy Richard S. [thanks,

Richard!] found Price Protectr, a spot that promises

to get you a refund if you've overpaid. (And you're

reading it right: Protectr isn't a typo.)

“I recently purchased a printer from Costco.com.

Two weeks later Price Protectr mailed me a notice



16

that Costco had dropped the price $50. That was

within Costco's price guarantee policy time frame. I

could either print that out and take it to a Costco

warehouse or e-mail Costco—which I chose to do.

Costco e-mailed back and said they had credited me

for the $50!

“A few minutes ago, I got a notification that the

keyboard I purchased from Fry's dropped $10.

“Life is getting a little cheaper and easier to find

price drops—and it sure beats watching ads to see if

a vender dropped a price on something you just

purchased.”

You can set a price on an item you're looking for

and when the product reaches the price you want to

pay, Price Protectr will ping you. Check the blog

<http://www.priceprotectr.com/blog/index.jsp> for de-

tails.

Adobe Reader 9
by Roger Radcliffe

The Users Group Netword, La Crescenta, CA

A
dobe has just released a new version of its

program that displays PDF's (Portable Docu-

ment Files), Adobe Reader v.9. It has a slick

new look and an interface that is much easier to use.

Its main improvement is a super quick launch time

from a web site click. Significant graphic acceleration

now allows fast smooth scrolling, improved 2D

graphic display and rotating 3D graphics from

within the reader.

Collaboration with other producers is now also

possible with version 9 and it supports Internet

conferencing features. Documents can now be digi-

tally signed with Adobe Reader. 'Search' and 'Find'

features are now faster and more accurate.

You can now annotate the documents you view

and save to your own computer without change to

the original document on the Web. The IRS uses

PDF files for their 'Forms and Publications' and now

it lets you fill out their forms on a PDF screen

display and then save the file to your hard disk for

later revision and printing. The Franchise Tax Board

also allows completion on the screen and printing,

but not saving-the last things for which I needed a

typewriter.

The PDF format allows writers to control the

document so that it can be read, but not altered over

the Internet without permission. Over 1.5 billion .pdf

files are now on the Internet. They include most

manuals, user guides, brochures, forms, and other

document. Web sites use PDF's when they want to

display formatted information, so a PDF reader is a

necessity for web users.

Photos placed into the PDF format can be viewed

by any Internet user without having to use specific

graphic format programs or even a PC. With a large

monitor you can read two pages side by side and

then print two pages on a sheet and two pages on the

back to save paper.

Many software programs (i.e. Word, Paper Port,

WordPerfect, PhotoShop) allow you to create your

own PDF and now, with Adobe Reader v.9, any

program can have its output placed into the PDF

format through an Adobe web site, and saved back

on your hard disk.

For early upgraders, Adobe Reader v.9 supports

Windows Vista and its new visual look as well. 
From the July 2008 issue of the newsletter of

TUGNET, The Users Group Network, La Crescenta, CA.
Their web page can be found at http://www.tugnet.org/

Society News

July Planning Meeting Minutes
by John McMillan

B
ob Avery, Tony Dellelo, Arpad Kovaks, Mike

Lavalle, John McMillan, Sharah Naas, Dan

Rothfuss, Steve Staub, and Tom Thompson

met at Sally Springett's home for the July planning

meeting. 

The meeting started with a review of the June

Society Meeting where David Wilson did a presenta-

tion on Print Management. He stressed the potential

savings in environments that have multiple users

and/or a variety of printing capabilities. This is more

likely to be of interest to commercial enterprises

though there was some consideration of selecting

printing equipment that might be beneficial to home

users.

Steve Staub mentioned that to date, 9 people

have signed up for the picnic which will be held at

the canal side pavilion in Fairport, August 12th. The

deadline for signing up is August first. Chef Al will

preside over the grill as he has the past few years

with dinner anticipated to start between 5:30 and

6:00. We are still looking for donations for the

auction Tom Thompson suggested. Contributions do

not have to be computer related and a letter support-

ing a tax deduction will be available if desired.

Auction rules will be explained at the picnic. 

In September we will meet at the Brighton

Library to hear about the concepts of open source

software. 

Arpad described several recent problems with

printing the Monitor. Six or seven volunteers spend

up to 7 hours a month at St. Stephens to print the
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Monitor for a cost, including mailing, of about $200.

More reliable equipment could reduce that time

commitment to 4 hours or less. A small, inde-pen-

dently owned, professional printing organization has

offered to print the Monitor for $270 per month.

Mailing costs would raise that figure to over $300

and could impact the quality of the newsletter. 

Arpad summarized by saying that if the laser jet

8000 should die, we have no current backup and

could not print the Monitor. He has been considering

possible alternatives. Perhaps with some creative

financing, the Society could purchase a new color

laser jet printer, similar to the 8000 but with an on

site service plan. The price of such an item is esti-

mated to be around $500. 

 In the short term we will continue to observe the

current process, looking for greater consistency while

assessing other practical and affordable alternatives.

Any proposed change involving a major expendi-ture

requires a majority vote of Society officers.  

July Meeting Minutes
by John McMillan

S
teve opened the business meeting saying

anyone whose dues are due should see him.

The planning meeting will be held the first

Tuesday of the month at Sally's house. Newsletter

assembly will take place Saturday July 12th at 9 at

St. Stephens Church. The next regular Society

meeting will be in September.

Ron Mattison led Help's Half Hour but there is a

continuing need for someone to perform this duty.

Members who have thoughts about topics for future

meetings are asked to share them with Mike Lavelle.

This evenings door prize was “Windows Vista, The

Missing Manual,” a book that requires a review.

Dave Thompson said the photography SIG will meet

the 1st Thursday in September and Carl

Schmidtmann mentioned that the Linux SIG will

also meet in September.

The deadline for picnic sign up is August 1st. It

will be held August 12th at the Perinton town park

beside the canal in Fairport, a place we used several

years ago. The fee is $5 per person plus a dish to

pass (A-I munchies, J-R salads, S-Z desserts). Gath-

ering time is 5 pm with supper as close to 5:30 as

possible. Several items have been pledged for the

silent auction but more would be welcomed.

Steve introduced Jim McBride, one of seven club

members living in Ohio. He was in Rochester for a

visit and made attending our meeting one of his

priorities. Russ Cooper, our speaker for the evening,

also came from Ohio but he now lives in Rochester.

After a brief biographical history, Russ launched

his topic, “Genealogy, Concepts, Software and Com-

parisons” by distributing a handout of the slides he

would be using. They started with some software

features newcomers should consider: 

1. Ease of Use 

2. Interface and Navigation

3. File Management and Organization

4. Charts and Reports

5. Source Documentation (He stressed accurately

identifying sources for data validation.)

6. GEDCOM (Genealogy data communication; how

data is transferred) 

7. Special Features

As each of these was discussed in subsequent

slides, Russ described advantages and pitfalls of

various approaches. Data sources span birth, mar-

riage and death certificates; census, tax and voter

registrations; obituaries; deeds; and mortgages.

Many are free like census data (both state and

federal), public and military records, church records

(including Mormon microfilms from overseas

sources) and public libraries (Rochester and Allen

County of Fort Wayne Indiana, for example). Other

privately funded sources are more expensive.

Data entry should be intuitive with an easy

learning curve. Spell checking and chronological

displays are very useful benefits as is a complete

family view screen showing a person, his or her

parents, spouse (s) and children. Pedigree lists going

back 5 or 6 generations are beneficial. Other life

events such as education, occupations, health data,

wars, and even weather abnormalities can be used to

construct more complete stories. Some software

packages allow GEO/GPS coding for building maps

of family events. Throughout the talk, Russ used

anecdotes of his personal findings to illustrate some

of the surprises that investigators might uncover and

tips for circumventing brick walls.

Russ discussed the varying capabilities of

PAF/Ancestral Quest; Legacy Family Tree1 and 2;

Family Tree Maker; the Master Genealogist; and

Roots Magic software before going on to demonstrate

some of the data collection and documentation

screens plus various reports they can provide. All in

all, a very detailed presentation on a topic of wide

interest.

See you at the picnic. Here are some things that

will be available: 1) Boom Box: Sony CFD-19,

FM/AM 2-band digital tuner, easy preset, CD to tape

synchronized recording, remote control: manual
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Picture Maker 100 by Lexmark New, color cartridge,

unopened: 12A1980, manual and installation CD:

Lexmark Z11, 3) Kodak PhotoDoc Color Scanner

handles from 3.5"x2" to 8.5"x14" paper, manual, and

software. 4) Casio Ez-label Printer, brand new-never

opened!

The Lighter Side
Customer: If I want somebody to send a reply to

my email … should I include a self-ad-

dressed, stamped envelope with it?


